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1 Getting Started
1.1 Installation

Download the UCx desktop client: https://www.tpx.com/ucx-for-desktop/

1.2 Sign in
When you first launch the application, you are prompted to sign in:

1 Enter your username and password (provided by your TPx PM or Administrator)

2 Select whether you would like UCx to remember your password

3 Select whether you would like UCx to sign you in automatically on subsequent launches

4 Click Sign In

1.3 Main Window

+

The following table describes the key icons used 
in the Main window:

When you start UCx for the first time, your 
Contacts list is empty. Use the Search 
field to find people and add them to your 
Contacts list. Contacts can also be added 
manually by clicking the Add        icon. 
UCx uses tabs for new chat sessions. The 
Search field allows searching for contacts 
by either name or telephone number.

My Information  View and update 
your information, for example, your 
presence, avatar, and location 

Contacts   
View your contacts 

Chat  Start an instant message 
conversation with a selected 
contact

Call History  
View previous calls 

Dial Pad  Make calls (it is integrated 
with the Main window) 

Directory  Searchable database of 
all company contacts

Preferences  Use for quick access 
to preferences and Call Settings 
such as Call Forwarding 

My Room 
This is your permanent 
communication room; 
participants can dial in 
to your audio bridge

Add
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1.4 Communications Window
When you start a call, chat, or screen share, the Communications window opens up to the 
right of the Main sidebar window. Here are the functions of the icons that generally appear 
on the Communications window: 

2 Contacts
Contacts are the people with whom you communicate and, in most cases; you see their 
presence and share your presence with them:

n Contacts  Actual people with whom you communicate

n Groups  Containers of contacts and/or conferences

There is no hard-coded limit on the number of contacts, however, the more contacts that are 
added, the more memory and processing is needed and the more difficult it is to find people 
without searching. Live search can be used instead of a very large local contact list and 
automatically searches the entire company directory, while keeping local memory and processing 
requirements to a minimum.

2.1 Add Contacts
When you sign in for the first time, there are no contacts on your list. To add a new contact, 
select Contacts > New Contact from the menu bar or click the         icon on the main 
window. In the resulting tab, you can select to add a contact, group, or other items.

Add Contact

In the New Contact tab, enter the contact’s information 
and click Save. By default, your presence information 
is always shared with a new contact if an Extensible 
Messaging and Presence Protocol (XMPP) address is 
provided and they will receive a buddy request from you.

When receiving a buddy request, there are two buttons 
for accepting and rejecting the request. Accepting the 
request shares your presence and adds the initiator to 
your contacts list. Rejecting the request will not share 
your presence or add the initiator to your contacts list. 
Closing the buddy request window only ignores the 
request for the duration of the login session. It reappears 
after the next login.

Desktop User Guide
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You can always share your presence information later by selecting Subscribe on the right-
click menu for a specific contact in the contact/directory list. Note that the contact must 
accept your subscription request for you to establish the presence relationship successfully.

Add Group

In the New Contact Group tab, enter the group’s name and click Add to Contacts. Then 
right click a desired contact, select Add to Group, then click the desired group name.

2.2 Edit Contacts
To edit a contact, select the contact and right-click anywhere in the area of the selected 
contact. A menu of options appears which allows you to either view or edit the contact 
profile. If you are in View mode, click the Edit button to go to edit mode. Not all contact 
card fields are editable.  

n Unsubscribe removes the presence relationship between you and that contact. 
This means you do not see the contact’s presence information and your contact 
does not see yours. To re-establish the presence relationship, select Subscribe. An 
unsubscribed contact remains on the contact list but is shown without an icon. Any 
contact that is not presence-enabled is shown in the same way.

n View Profile opens the Contact Information dialog box where you can add, edit, or 
remove information. This works for both normal and conference contacts.

n For groups, choose the Edit menu option to rename a group. 

Once done with all changes, click the Save button.

2.3 Filters
You can filter contacts in two ways:

n Use the Search field to search by contact name. The 
contact list is filtered in real time as you type.

n Or right click the Contacts icon in the left pane to 
display only specific types of contacts such as online 
contacts. You can also sort contacts based on first or 
last name or choose whether to display the contact’s 
avatar and availability status in the contact list.

When you make a contact one of your favorites, the 
favorite group shows on top of the contact list. It can 
be minimized by clicking the up arrow to the right of the 
favorites group section. Other groups show below that 
and function in the same manner.
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3 Presence
Presence means that your friends can see whether you are available to communicate, e.g. “I’m 
busy” or “I’m available”. For each contact you have subscribed to, you can see their presence. 
Similarly, your contacts can see your presence on their contact list.

Automatic presence. This is the Available status where automated presence status 
(e.g. In Call) overrides the Available status.

Indicates that the user is online and ready for communication. It also can indicate the 
contact is available on mobile UCx or a compatible desktop phone, and not UCx. This 
status is used until you change it and automated presence status does not override.

Indicates that (1) the user is online but has been idle or away from their computer for 
more than ten minutes; or (2) only the mobile client is online and in the away status.

Indicates that (1) the user is busy and does not want to be disturbed; (2) the contact 
is busy due to a call; or (3) the contact is in a meeting. The last two reflect automated 
presence status. Busy – In Call overrides Busy – In Meeting, so the latter is only seen 
if there is a meeting but no call.

Indicates that (1) the user is offline and the only available contact method is calling or 
chatting; or (2) the user is in a call but is not logged in to XMPP (presence and chat).

Indicates that a subscription is pending and the contact has not yet approved 
sharing their presence.

UCx can automatically update your presence to the following:

n Busy – In Call

n Busy – In Meeting (Windows only)

n Available (desk phone)

The avatars are retrieved at login, when the contact is added, and when the contact comes online. 

If you see an error message at the top of the main window “XMPP Unavailable”, it means that the 
XMPP connectivity has been lost for chat and presence. However, you can still make calls. You 
should contact TPx Customer Care at 877-344-7441.

Have the Outlook calendar automatically change your presence to Busy – In Meeting by enabling 
this in the Preferences > Integrations tab (native desktop Outlook only). The presence update is 
only triggered by appointments and meetings that are in the Show me as busy state.

Location

Location in presence is done based on the IP address that the machine is using. On Windows, 
the IP address is mapped to a physical location. On Mac OS, the operating system location is 
utilized. You will be prompted to accept location usage. Change the location manually by clicking 
your avatar (if presence controls are not already expanded) and then Set Location to choose 
Automatic or Manual.

n Available (mobile)

n Away on mobile

n Offline and Busy – In Call
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4 Chat
4.1 Chat View

Start a chat tab using one of the following methods:

n Double-click a contact from the Contacts list or search results. (This can be changed to 
a single click in preferences by changing to the single-click mode.)

n Hover (or right-click) on a contact avatar and click the Chat icon.

n Click the Chat History icon on the sidebar and double-click on a chat entry.

n In the main window, click the + button and choose New Message.

When you initiate a chat, the Chat tab opens to the right of your sidebar. Chatting with a 
contact is possible only when you are both online. If your contact initiates a chat, you see a 
pop-up notification in the bottom right-hand corner of your screen. If you close the Chat tab 
and open it again, sent chat messages are shown in the tab as chat history. 

Enter your text at the bottom of the chat window. You can also ad emoticons and files to 
the chat. Initiate calls, video calls, or calls from other devices using the green buttons at the 
top of the chat window. You can also separate the chat as its own floating window by using 
the pop-out         button in the upper right of the chat window.

To enter a line break in the text field, you can use the following key commands:

n CTRL+ENTER (command+enter on Mac)

n SHIFT+ENTER

n ALT+ENTER

All sent and received chats are encrypted and stored locally in the chat history as well as 
synced across devices at the time of login. This way users can see their full chat history, 
securely, from any device.

4.2 File Transfer
File transfer functionality is only accessible through the Chat tab.

1) Click the Send File       icon located at the top left of the text entry field.

2) From the dialog menu, select the file to be sent and click Open. You can also drag and 
drop a file into the Chat tab.

3) Once the file offer is “issued” and during its transfer, you can cancel the transfer (at any 
time) by clicking Cancel.

4) Accept an incoming file transfer by clicking the Accept button. Reject a file transfer 
offer by clicking the Decline button.

After the file transfer has completed, the received files can be opened or viewed in the 
file manager by using the File received, click to open, and Show in folder links. In error 
situations, partially received files are not deleted automatically.
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4.3 Group Chat
Start a group chat by “multi-selecting” and right-clicking from the main window contact list. 
Or expand a 1-to-1 chat into a group chat using drag-and-drop or by having a multiparty 
call. Only the chat owner can add more participants. More people can be added later to the 
chat by drag-and-drop.  

A group chat works the same way as a one-to-one chat in a tabbed view. All messages 
from anyone are sent to everyone else. All contacts need to be online to be able to 
participate in a group chat. You cannot invite an offline contact or one that is not on UCx. 

A group chat history is saved and is available to view later in the Messages tab of the main 
window. Deleting a chat room is not supported.

5 Audio and Video Calls
Make an audio or video call using one of the following methods:

n Right-click one or more contacts from the Contacts list or search results and select the Call, 
Call from Other Device, or Video menu item. 

n Type the called number in the Search field and click the call button that appears underneath 
the field.

n Hover over the contact list avatar and select one of the audio or video call buttons.

n Open the dial pad, enter a phone number, and then click 
one of the Video Call, Audio Call, or Call from Other Device buttons.

n On the Call History list, double-click a call entry.

n In the Communications window, click the Video Call, Audio Call, or Call from Other Device button.

There is no hard-coded limit on the number of contacts. However, the more contacts you add, 
the more memory and processing is needed and the more difficult it is to find people. Live search 
can be used instead of a large local contact list and automatically searches the entire company 
directory, while keeping local memory and processing requirements to a minimum.

NOTE: If dialing a phone number that requires additional dual-tone multi-frequency (DTMF) 
tones (for example, a conference bridge), you can type the numbers on your keyboard while the 
Communications tab has focus or open the dial pad in the Communications tab.

The following table describes additional Communications window icons and explains what you 
can do with them, for voice and video calls:

Add or remove video from the call.

Mute your microphone.

Put a call on hold. If you hold the call, the other party cannot “unhold”. This freezes 
a video call to the last frame of the video feed. In both voice and video calls, this is 
communicated to all parties by a notification appearing in the middle of the screen.

Access the Call Options menu. In the Call Options menu, you can find different 
actions to use for a call depending on your settings.
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In the Options menu, there are the following options:

n Transfer a call to a third party.

n Put the call on hold. Note that if you hold the call, the other party cannot “unhold”. This 
freezes a video call to the last frame of the video feed. In both voice and video calls, this 
is communicated to all parties by a notification appearing in the middle of the screen.

n Adjust the volume bar to adjust the volume. Dragging it all the way to the left mutes 
your speakers.

n Enter additional digits using the dial pad at any time during the call (for example, to 
insert a conference number). The dial pad is not movable.

n Toggle between the audio headset and speakers. You must specify a different device 
for a headset and a speaker in Preferences to be able to use this feature.

n Add participants to the call.

When establishing a call to a contact, you can choose several ways to call. 

n Right-click the contact you want to call and select the Call menu item. You can choose 
the number to call from a right-click menu. There can be several phone numbers 
available in the menu. The work phone is the default and top-most number is followed 
by mobile and other numbers. This also applies to the transfer and conference 
windows. However, in certain cases, the transfer/conference default number can differ 
from other call options in other menus.

n The default call type can also be selected using accessibility menus: Calls > Dialing 
service. This controls the default call type when using call buttons.

n Dial a number in the Search field to make a call.

You cannot have two simultaneous calls with the same person.

UCx does not add video to an audio call without end-user consent. This also applies 
to blind video call transfer cases where audio-only music on hold is used; this may 
result in the transferred call being reduced to audio.

5.1 Select Audio Devices
If you have multiple audio devices available for your microphone or speakers, select the 
preferred audio device before starting a call.

Windows

1) Select Options.

2) Select Audio/Video.

3) Set Output & Input devices for Headset and Speaker.

4) Set capture device and video size for video.

5) Place a test call to check your settings
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Mac

1) Select UCx from the top menu.

2) Select Preferences.

3) Select Audio.

4) Set a playback device (speakers).

5) Set a recording device (microphone).

6) Click OK.

If “Use default” is selected, then UCx uses the default device set in the operating system 
preferences. For Windows, if “Default Communication Device” is defined, it is selected over 
the “Default Device”. If you are using headsets, you can also select a separate device than 
the headset for alerting incoming calls.

Note that on Mac OS, it is recommended to disable “Use ambient noise reduction” in 
System Preferences to reduce echo.

5.2 Call From Computer (Audio/Video)
Select a contact from your contact list to start communication and click the desired 
communication button. To communicate with someone who is not on your contact list, 
type a phone number in the dial pad.

5.3 Call From Other Device
The third option to communicate in the row of communication buttons is Call from Other 
Device. When you click this icon, the desk phone starts ringing and the call is established 
from your desk phone or other devices you have setup. Automatic Busy – In Call presence 
also works with the Call from Phone feature.

5.4 Answer Call
When someone is calling you, you see a pop-up notification on your screen. You can 
choose to answer, reject the call, or silence the incoming call by closing the pop-up 
notification window. If you silence the call, the ringtone is silenced but the caller does not 
see anything on their end and your other devices will continue to ring. If you close the 
incoming call pop-up notification to silence an incoming call, then you do not have an 
option to answer or reject it anymore. 

When someone is calling you with a video, you see the same pop-up notification; however, 
the options are answer with video, answer as voice only, silence and chat, reject, or silence 
(by closing the pop-up window). If you decide to answer as voice only, the call is voice only.
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5.5 Contact Name Lookup for Incoming Calls
UCx performs a local contact search for incoming calls. If the number matches one of the 
contacts on the UCx contact list, the name is shown on the incoming call screen along with 
the alert. Both the display name and phone number are shown when available.

If there is no match to a local contact, UCx looks for a match in the Telephony Directory 
and other available directories, and if a match is found, the available information is shown 
for the incoming call. If there is no match in the Telephony Directory, the display name is 
taken from the available information in the incoming call.

Whenever you retrieve your call logs/history, UCx does a lookup in the local contacts and 
populates the name if a match is found.

5.6 Missed Call or Communication
When you have one or more missed calls or other types of communications, there is a 
notification on the left-hand side of the navigation pane in the Main window. Clicking the 
icon takes you to the missed communication in the Communications History view.

5.7 Full Screen in Video Call
Full screen mode can be activated by clicking the Full Screen button or by double-clicking 
anywhere on a video.

Exiting full screen mode is done by pressing the Esc key (on both Windows and Mac OS) 
or by double-clicking the window. Exiting full screen makes the video call go back to its 
original state (even if there was resizing of the window previously before going full screen).

In a full-size window, you can see a similar Options menu at the top. It has the same 
functionality as it does in the normal view. When you move the mouse, the top bar and 
lower communication buttons appear on top of the video.

5.8 Call Waiting
You can have one active call at any one time.  If you receive a new incoming call and 
accept it, the existing call is put on hold and you can change between these two calls by 
using the Hold and Unhold buttons.

5.9 Call Transfer
Blind call transfer is available in the Communications window; choose the Transfer Call 
menu item to transfer the call to someone else (native Desktop only). Attended call transfer 
is also available in the same window, first call someone to check if the called party can take 
the incoming call and then transfer the incoming call to the desired called party. You can 
also search for the transferred-to party.
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5.10 Message Waiting Indication (MWI) and Visual Voicemail
It is possible to call voicemail from the dialer by long pressing the “1” icon in the dialer.

Missed calls are indicated by an icon in the Main window. Note that the MWI icon is in 
the same place when it indicates a new voicemail. With Visual voicemail you can see all 
voicemails in a list and play them inside the Main window.

The following settings need to be enabled to have Visual Voice Mail:

n  Voice messaging enabled

n “When message arrives, use unified messaging” option enabled

n “Use Phone Message Waiting Indicator” option enabled

5.11 Message Waiting Indication (MWI) and Visual Voicemail
Active Communications appear at the top of the Contacts list in the Main window. This area 
provides an easy view to see the people with whom you are communicating. Double-click 
an active communication item to bring this Communications tab to focus if the call window 
is separately shown. If the call window is integrated, you can use the pop-out button to 
show it separately.

n Pause

n Switch to video

n Mute

n Transfer

5.12 Pull Call
Pull Call allows you to pull an ongoing call from one of your devices to another one where 
the Pull Call feature is used (native Desktop only). Pull Call can also be used with FACs, in 
this case, *11. 

5.13 Headset Support
You can control incoming and ongoing calls from a compatible headset. The feature set 
supported is answer/hang up as well as mute/unmute. Volume control operations are not 
reflected in the UCx UI. 

5.14 Call Center Agent Login
You can also log in to call center queues if you are a call center agent. Once logged in, you can:

n View your call queues 
n Join your call queues 
n Set your agent ACD status (available, unavailable, wrap-up)

With suitable ACD status such as “Available”, incoming calls to the queue are routed to 
your client. With “Unavailable” or “Wrap-up” ACD status, incoming calls to the queue will 
not be routed to your client. Dynamic ACD status updates are not supported if the ACD 
status is changed somewhere else.

n Conference 

n Park

n Switch Audio Device
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6 Application or Desktop Sharing
To share your desktop or individual application:

1) In the Communications tab, click the Sharing        icon. (This does not yet start the “share”.)

2) Select either to share your entire display or one of your open applications and double click to 
Start Sharing. The share widget let you control share settings such as Preview which shows 
you what participants are seeing and Pause that pauses sharing.

3) To stop sharing, click the Stop button. Video call is also available while sharing.

Desktop sharing works the same way in both My Room and in ad hoc sessions. For participants 
without UCx, use the separate Guest Invitation link, by right-clicking the My Room icon. Share 
selector is not dynamically updated while the selector is open and minimized applications are not 
available in the list of applications to share.

n If you are first in a video call and then start sharing, your own video is not shown due to 
limited space available, but you can make it visible using the Main window menu in the 
bottom right-hand corner by selecting “Show Own Video”.

n If you are using dual monitors, you can choose which monitor to share. You can check the 
primary monitor in the operating system settings.

n You can also remove desktop share participants. They are also removed from the group chat 
at the same time. If needed, the removed participants can join later.

n In addition, participants can share by clicking on the Share button; however, the room owner 
can prevent this at any time. Only one person can share at any one time in a session. 

n When video and share are used at the same time, double click on the broadcast at the top of 
the screen to swap the main view.

7 My Room
My Room is an always available and permanent room you can use to chat with anyone that joins. 
The full functionality of My Room includes desktop sharing, audio/video conferencing, and chat 
combined. 

My Room is started by clicking on the My Room      icon on the top right-hand side of the 
Main window. My Room is started automatically using your permanent chat room. Add more 
participants by dragging and dropping them into the Communications tab or the Conference 
menu. Otherwise, they can join your room by right-clicking your name on their contact list and 
choosing the Join Room menu option. Once people have joined the chat room, they can click 
on the Call button of that window to join the conference. The room owner can also share their 
desktop.
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In addition to the owner of the room, participants can also share the desktop but only the owner 
can add more participants. This applies to both My Room and ad hoc sessions.

1) Select Copy Guest Link to copy an invitation link to the clipboard. Paste this link, for instance, 
to a meeting invitation email to allow UCx participants to join the conference in one click from 
e.g. Outlook or other email applications. 

 The link has two parts: one for UCx users and another one for users without the UCx client. 

 The Room Info area indicates the conference bridge details of your My Room. You can also export 
the attendee list using the related participant menu available via the options icon (three dots).

The Communications window has an icon that provides the same Context menu previously 
discussed. For more information on desktop sharing, see section 6 Application or Desktop 
Sharing. Desktop sharing works the same way for both My Room and ad hoc sessions.

All My Room sessions start as chats but call and/or share can be added to the session while in 
progress. File transfer is not supported in My Room or ad hoc sessions. Aadditionally, you cannot 
transfer or conference My Room calls. My Room calls cannot be conferenced or transferred.

Moderator Controls

You can control the functionality available to participants if you are the owner of the session in My 
Room. You can do the following:

n Dismiss one or more participants. This ends all sessions (group chat, audio, video, and share) 
when the participant is using UCx for Desktop

n Mute one or more participants

n Lock or unlock the room (when locked, no additional participants can join)

n See active talker indication (room owner only)

n See full audio participant list

n Choose who can join without separate authorization (moderated My Room):

– Require only guests to request access

– Require everyone to request access

– Allow everyone to join automatically

To invoke the features, you can use the right-click menus, or you can click on the moderator 
control icons of a participant. Note that most features are not available via icons. To dismiss or 
mute all participants or lock the room, use the right-click menus available for your own icon at the 
top of the participant list.

If you are not the owner, you can only see the (chat) participant list.
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8 Universal Search
UCx supports a universal search of the enterprise directory, outlook directory, enterprise common 
directory, and group common directory as well as chat messages and calls. This takes place in 
the Search field that is used for calling and both a local and presence-enabled contact list search, 
the results are separated onto their own tabs:

n Chat messages

n Contacts

n Calls

To make a call, click on the Call icon underneath the Search and Dial field after you have provided 
the called number.

UCx automatically searches the local contacts and presence-enabled contact list in addition 
to the enterprise and other directories at the same time. As soon as there are results from the 
enterprise or other directories, these results are shown on a separate list in the Main window. 
Additionally, there may be other search result groups from other search sources such as Outlook 
(native Desktop only).

Search results are displayed differently depending on the results of the contact list and directory 
search. If Outlook search is enabled, there will be an Outlook results section.

The enterprise directory searches all available fields for the search string. By default, it waits for 
1.5 seconds before it sends the search request to the server to minimize unnecessary load on the 
server.

n While looking for Philip Moorefield, the following search string can be used: “Phil Moore”. An 
exact match of the first name is no longer required.

n Looking for Joe Gold and using “jo go” or “go jo” as a search string provides the same results.

Typically, when adding a contact using directory search results, all available information, including 
phone numbers and first and last names are imported with the contact. Outlook integration 
(search and calendar integration) on Windows requires one of the following versions installed on 
the desktop:

n Outlook 2013

n Outlook 2016

n Outlook 2019

Additionally, other related considerations are as follows:

n The client searches for contacts and calendar entries in the default Outlook account. The 
account is set to the default via File > Info (left pane) > Account Settings > Data Files. 
Select an account and mark it as “Set as Default”. After making this change, sign out and 
sign back into the client and it now searches that account for contacts and calendar entries.
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n The client searches the Outlook contacts only on the local machine (that is, the Outlook 
Address Book). There is no Exchange server lookup performed. In addition, all directories 
in Outlook are searched for contacts, even deleted folders. The Contacts directory can also 
have multiple levels of subfolders.

Every minute, UCx reads Outlook appointments. If there is an appointment running at the current 
time, then the presence is shown as Busy – In Meeting. Overlapping appointments are also 
handled. Following are some examples of UCx operation with Outlook when time is 9:10 AM.

n There is meeting “A” 9 AM. through 10 AM. Presence is shown as Busy – In Meeting.

n Presence is explicitly changed to Available at 9:15 AM. Presence is shown as Available.

n In the next minute, UCx again reads the appointments and sees that “A” meeting is running; 
however, the presence was already explicitly marked as Available and presence is not shown 
as Busy – In Meeting but Available.

n There is an overlapping meeting “B” 9:30 AM through 10:30 AM. Presence is shown as Busy 
– In Meeting when the time is 9:30 AM. 

When deleting a meeting that is currently ongoing in Outlook, the presence status remains as 
Busy – In Meeting until the next time Outlook appointments are checked (once every minute) and 
after that, presence is shown as Available. This change may be instantaneous, or it may take a 
minute depending on how close the timer is to being triggered.

The presence update is only triggered by appointments and meetings that are either accepted by the 
user or made by them. All day meetings do not trigger a presence change to Busy – In Meeting.

9 Full Enterprise Directory
UCx allows for browsing of an entire enterprise directory. To view the enterprise directory, click the 
Directory       icon on the left-hand side of the navigation pane. 

 Call History
The Call History       icon is on the left-hand side of the navigation pane. The Call History view is 
divided into two tabs:

n Calls

n Visual voice mail

Clicking a Visual Voice Mail downloads the message so you can play it. UCx saves a Call History 
for placed, received, and missed calls. Call History makes it easy for you to redial and call back 
when you have missed a call, or you want to easily dial a contact with whom you have recently 
spoken. Each call has a separate entry in the list.

Double-click on a name in the list to call back directly. (This calls back the same way you 
previously spoke, for example, if you were in a video call, double-clicking starts a new video call). 
Double-clicking an incoming call item in the Calls tab makes a call.

The Call History missed communications badges can be cleared by using the right-click menu 
from the Call History button on the left pane (native Desktop only). The menu provides options to 
mark “All as viewed”, “Voicemails as viewed”, and “Calls as viewed”.

10
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 Highlight to Call (Highlight Text)
Click-to-Call using highlighted text and global keyboard shortcuts. Users can highlight text 
anywhere in the desktop machine to make a call and define the default call type used for making 
the call using the shortcut defined in Preferences. On Mac OS, you must define the shortcuts on 
your own using the instructions provided in Preferences. The order in which key combinations 
are pressed may be significant in some cases if the operating system has reserved some key 
combinations for other purposes.

 Emergency Calls
It is not recommended to use the client to make emergency calls. If one is made, however, it will 
connect to the local Public Safety Answering Point, with the registered address on file for the user.

 Password Change
A dialog box automatically opens when your login password must be changed. You must provide 
the password two times for verification purposes. Using a menu in either the bottom right-hand 
corner or the top of the Main window, your password can be changed at any time.

 Options/Preferences
Options/Preferences provides access to available 
settings for UCx. Click the Gear icon at the bottom 
of the blue pane of the Main window for Options 
(Windows) or Preferences (Mac OS).
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14.1 General
Language

Select your language then click OK or Apply and the change takes effect immediately. 

Login

Enable or disable automatic login when starting the application and control the remember 
password feature as well as enable the Update Password feature.

Notifications

Usually there is a confirmation pop-up notification each time you remove a contact or chat 
history record. By selecting one or all the check boxes, you can disable the confirmations 
when deleting information. You can also control whether there is always a pop-up 
notification for publishing location information. Typically, this is shown at login. You can also 
select whether to receive a notification before ending communication or holding a call.

Appearance

Enable Single-Click Mode allows you to launch communications sessions without tabs 
and with a single click. This shows only your most recent chat and also changes how call 
history, phone dial pad, and preferences are displayed.  

Accessibility

Enable Pop-up Errors allows UCx error pop-ups to be shown in addition to the usual error 
text shown at the top of the Main window.

Enable ToolTips is enabled by default. For accessibility, screen reader/VoiceOver reads 
all ToolTips, which may be frequent and hence disturbing. For this reason in accessibility 
cases, it is recommended to disable ToolTips.

You can also enable spell checking and auto-capitalization.

14.2 Audio/Video
Headset

Here you can specify what are the output and input devices used for the headset when 
toggling between the headset and speakers. Note that to be able to toggle between the 
headset and speakers during calls, you must specify a different device for each. Using the 
default for both results in the same device being assigned to both so toggling does not work.

Output Device

Choose a headset, PC-integrated speakers, or external speakers for audio output. Your 
external playback device is selected by default (if you have one connected).

Input Device

Choose a headset microphone, PC-integrated microphone, or external microphone for 
voice during calls. Your external recording device is selected by default (if you have one 
connected). You can also choose automatic gain control and test your recording device.
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Speakers

Here you can specify what are the output and input devices used for speakers when 
toggling between the headset and speakers.

Note that to be able to toggle between the headset and speakers during calls, you must 
specify a different device for each. Using the default for both results in the same device 
being assigned to both so toggling does not work.

Output Device

Choose a headset, PC-integrated speakers, or external speakers for audio output. Your 
external playback device is selected by default (if you have one connected).

Input Device 

Choose a headset microphone, PC-integrated microphone, or external microphone for 
voice during calls. 

Ring device (alert signal)

Select the audio device that is played when you receive an incoming call.

Ring Signal

You can select your own ring signal. The same signal is used for both voice and video 
calls. Click Play to hear the currently selected sound.

Capture Device (Video)

Select a camera that you want to use for video calls. Your external web cam is selected 
by default (if you have one connected).

Video Size

Select one of the available sizes. Note, however, that higher sizes require more bandwidth 
and a more capable central processing unit (CPU).

Click Test Call to make a test call to test voice quality.

14.3 Incoming Calls
Available call management services for incoming calls:

n Do Not Disturb

n Anonymous Call Rejection

n Call Waiting

n Remote Office

Do Not Disturb
When you activate this service, all calls are typically blocked by the server and are sent to 
voice mail, using the “Busy” greeting. Enable this service by enabling the service icon.

n Call Forwarding

n Simultaneous Ring Personal

n Anywhere
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Anonymous Call Rejection
The Anonymous Call Rejection service allows you to reject calls from parties who have 
explicitly restricted their identities.

Call Waiting
The Call Waiting service allows you to answer a call while already engaged in another call. 
You can enable or disable server-based Call Waiting in the Preferences and Outgoing 
Calls tab. If you disable Call Waiting, the second incoming call is not connected, and the 
caller is rerouted to voicemail, using the “Busy” greeting.

Remote Office
This service allows the use of any phone as the office phone from a charging and 
numbering perspective. For instance, a hotel room phone can be used as the office 
phone. Enable Remote Office by clicking the service icon and specifying a phone number 
to be used as the Remote Office number.

Call Forwarding
Enter a number to which your calls should be forwarded. Different variants of Call 
Forwarding are supported, such as forwarding always, forwarding when busy, and 
forwarding when you cannot answer or when you are unreachable. In addition, you can 
specify the number of rings before Call Forwarding is triggered.

Simultaneous Ring Personal
Add up to ten additional numbers that you would like to ring in addition to your 
primary number when you receive a call. In addition, specify whether you want answer 
confirmations and if you would like to receive calls when already on another call. This 
service is an older variant of Anywhere.

Anywhere
Anywhere simplifies communications for on-the-go users and remote users by extending 
the features of a desk phone to any other fixed or mobile device, regardless of the 
network or handset manufacturer. Callers dial one number and can reach you on any 
phone the user chooses. A desk phone, cell phone, and/or a soft phone may ring 
simultaneously.

Experience voice call continuity with the ability to move live calls from one device to 
another without hanging up.

Add locations (numbers) that can be used in the service via the Add Number field. Use 
the Alert all locations simultaneously check box to activate parallel ringing. Click on the + 
icon to see more options.
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The Don’t divert check box prevents a call from ending up as a voice mail, which can be 
problematic in, for example, conference call situations.

Select Answer Confirmation to receive a separate audio prompt when answering a 
call from that number (location). It may be useful in cases where, for example, mobile 
numbers are being used to prevent incoming calls going to mobile voice mail in the event 
your mobile phone is turned off or loses service.

Select the Call Control check box to enable the server platform to provide mid-call 
services such as Call Transfer and Conferencing for that number (location).

14.4 Outgoing Calls
Available call management services for outgoing calls:

n Block My Number Caller ID

n Automatic Callback

n Highlight to call

n Register to call

Automatic Callback
The Automatic Callback (ACB) service allows you to be notified when the previously called 
busy party becomes idle and is connected without having to redial the phone number.

When you call another party and the call cannot be connected because the line is busy, 
you are prompted to make an Automatic Callback request (for example, “The line you are 
calling is busy. Press 1 if you would like to be notified when the line becomes available”).

If you select Automatic Callback, the system monitors the busy party and automatically 
establishes a call when the busy party becomes available.

Voicemail
You can specify various voice mail settings, such as which calls are sent to voice mail, 
what kinds of notifications you receive when voice mail arrives as well as controlling how 
fast the voice mail greeting is played and if callers are allowed to leave voice mails. In 
addition, you can control how callers can end up going to voice mail.

Services
This section is reserved for users who are also call center agents.

Integrations
This section is not commonly used.
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Advanced
The Advanced view contains two subsections:

n Troubleshooting

n Proxy

Troubleshooting

Logging is used for troubleshooting. You may be asked by your service provider to turn 
on logging and then send a log file directory contents. You can choose basic logging or 
more detailed logging to be enabled. Detailed logging can consume memory resources, 
so it is not recommended to have it enabled for a long period of time.

You can also clear the logs and open the logging folder as well as enable and disable 
Google Analytics.

Proxy

Select how to handle HTTP proxies. By default, no proxy is used and these settings 
should only be adjusted if instructed by your administrator or TPx.

Sign Out of UCx
The Advanced view contains two subsections:

Windows

1) Click the UCx logo in the Main window title bar.

2) Select Sign Out.

or

Mac OS

1) Select UCx from the Main menu.

2) Select Sign Out.

Exit Application
To exit the application completely, follow these steps:

Windows and Mac OS

Close the Sign In window.

Windows

1) Select the UCx logo in the Main window title bar.

2) Click Exit (a keyboard shortcut can also be used).

Mac OS

1) Select UCx from the Main menu.

2) Select Quit UCx (a keyboard shortcut can also be used).

NOTE: Closing the Main 
window (not the Sign In 
window) does not exit 
the application but rather 
minimizes the application 
to the system tray 
(Dock). This allows you to 
continue to receive calls 
and messages without 
having the contact list 
window appearing on the 
desktop.
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 Uninstallation
The uninstall procedure is different for Windows and Mac OS.

Windows
Uninstallation is performed by launching the Windows uninstaller via the Start menu or by using 
the Windows “Remove programs” view inside the Control Panel. Windows uninstallation does 
not require you to select any options. The language used for the Windows Start menu string 
“Uninstall” is taken from the language chosen when installing the client. This string cannot be 
changed after installation.

All files are deleted at uninstallation, except for the following files:

n Registry entries

n Account files are only deleted when explicitly allowed by the end user on Windows.

Mac OS
Uninstalling is performed by simply dragging the application folder from the Applications directory 
to the trash can; however, account files are not deleted. If you want to remove account files, they 
must be manually deleted. These are the file locations for the account directories. The following 
locations apply for all account directories:

For branded clients:

/Users/<USERNAME>/Library/Application Support/<company_name>/<application_name>

 Version Control and Automatic Upgrade
You may receive a notification to upgrade UCx to a newer version. In automatic upgrade dialog 
you can choose between:

n Remind Me Later  You will get a new pop-up at next login.

n Skip This Version  You will not get a new pop-up for this version, but the next or if you 
manually check for updates in the menu.

n Update Now  Upgrade is done immediately.

The upgrade may be recommended or mandatory. If it is mandatory, then UCx does not start 
before the upgrade is done.
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 System Requirements
System requirements are as follows on native Desktop:

n Operating system: Mac OS 10.12 Sierra, Mac OS 10.13 High Sierra, Mac OS 10.14 Mojave, 
Mac OS 10.15 Catalina, Windows 8/8.1, or Windows 10 (Classical view only).

n The installation footprint is approximately 125 megabytes (MB) on Mac OS and 215 MB on 
Windows.

n For voice calls, a sound card, speakers, and a microphone or a headset are required.

n For video calls, a web cam is required.

Minimum system requirements for respective operating systems need to be fulfilled, with the 
following additions:

n A minimum of 2 GB random access memory (RAM) is required.

n A minimum 1.5 GHz CPU is recommended. 

n A minimum dual core CPU is recommended for video calls.

For high definition (HD) video, the following is recommended:

n HD camera

n HD resolution support in display

n Quad Core x86 or equivalent at a minimum

n 4 GB RAM

VDI environments are not supported.

 Troubleshooting
Why am I getting a Windows Defender pop-up when launching UCx?

Sometimes Windows Defender may report an issue when initially launching applications such 
as the UCx Client. In that case, click Allow. If you do not have administrative permissions to your 
machine, contact your system administrator.

Why can’t I change the avatar?

Double-clicking the avatar should open a File Explorer view to select a file. If your connection is 
lost, changing the avatar fails. A lost connection is indicated in the Main window’s top notification 
area.

My contacts are all offline and my client’s status bar says “XMPP unavailable”.  
What does this mean?

It means that the XMPP connectivity has been lost for chat, as well as for presence; however, you 
can still make calls. You should contact TPx Support or your system administrator.

Why am I offline?

If you have selected “Offline” status, you are shown as offline to others. Another possibility is that 
you may have lost your Internet connection. In this case, the client does not log out, but rather 
enters an offline mode where a contact list is available, but communication is not possible.
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Why can’t I have more video resolutions available?

You can choose your video resolution from Preferences and the Video tab. Your selection is used 
by default for future video calls. The available resolutions are automatically presented based on 
your camera.

Why can’t I change my username and password?

Username and password editing is not supported in the client. To edit your username or 
password, contact TPx. The exception is login password expiry. When it expires, you can change 
the password in a separate dialog window.

Why does my all day calendar entry not trigger Busy – In Meeting presence status?

Not all meetings trigger a presence change to Busy – In Meeting. To trigger the presence update, 
the meeting must be in the Show me as busy state.

Why can’t I change the XMPP address of a contact?

This is not supported, however, you can delete the contact and add a new one.

Why does my location show an incorrect address?

It is done based on the public IP address that the machine is using. The IP address is mapped to 
a physical location. You can manually change the location by clicking the avatar and changing the 
location icon.

Why is the UI different for me and my colleague?

During startup/installation, UCx should typically come up with same UI. However, differences may 
arise between specific users due to the following aspects:

n Account specific configurations on the server

n Features/services enabled/disabled on the server configuration (call forwarding or Do Not 
Disturb [DND])

n Differences in the individual machine’s device drivers or hardware peripherals

During startup/installation, UCx should typically come up with same UI. However, differences may 
arise between specific users due to the following aspects:

n Different TNs, Contacts, Groups, Call History

n Differences in voice mail settings

n Bridge details (if applicable)

n Race conditions

n Race conditions between MS Teams and UC-One applications
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Although MS Teams and UCx are different, independent applications, there are cases where race 
conditions will take place with USB headset connectors.

1) A call is started in UCx, either incoming or outgoing (this is a process with the call server 
rather than with Windows).

2) Because of 1, UCx tells the connector that there is a call ongoing, so the connector asks the 
headset to update to “off hook” status.

3) Another communications application, for example, MS Teams, gets a notification from the 
headset about the “off hook” status. From its point of view, there is no ongoing call, hence 
may instruct the headset to change status to “on hook”.

4) The headset notifies the connector that the status is updated to “on hook” so the connector 
notifies UCx that the call is hung up.

5) There may be machine-specific issues that cause the USB connector to work in one 
machine and not work in another, using the exact same version of the client.

6) If there are several UCx versions installed (not a supported configuration) the standard HID 
connector may get installed several times, one instance being connected while another 
would be disconnected.

Error message: Multiple UCx versions
If you see “Extensions unavailable” at the top of  
the main window, it may mean multiple UCx  
versions are running simultaneously.

If the Integrations screen shows USB Device 
Add-In multiple times, it indicates multiple UCx 
versions are installed on the machine. Uninstall 
previous versions and install one new instance.

You can see this issue displayed in 
Preferences > Integrations.
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Appendix A: Keyboard Shortcuts for Desktop
The following table lists the currently supported keyboard shortcuts (native Desktop only). You can 
use these keyboard shortcuts to quickly perform frequently used actions. The characters used 
are lower case. The shortcuts are also indicated in the accessibility menus.

Windows Shortcuts Mac Shortcuts What It Does

CTRL -2 Cmd-2 When a contact is selected, this calls the contact with audio

CTRL -3 Cmd-3 When a contact is selected, this calls the contact using call from phone

CTRL -4 Cmd-4 When a contact is selected, this calls the contact with video

CTRL -5 Cmd-5 When a contact is selected, this joins their room

CTRL -6 Cmd-6 When a contact is selected, this opens an email-sending window using the 
default email client

CTRL -I Cmd-I When a contact is selected, this opens the contact card for the contact

Shift-CTRL-F Shift-Cmd-F When a contact is selected, this makes the contact a favorite

CTRL-delete Cmd-delete This deletes the selected contact.

CTRL-arrow down Cmd-arrow down This decreases the volume

CTRL-arrow up Cmd-arrow up This increases the volume

CTRL-space CTRL-space This mutes the client (while in a call)

CTRL-D Cmd-D This turns on the Do Not Disturb service

CTRL-P Cmd-P This pulls an ongoing call from your other device to UCx

Alt-shift- CTRL-P Alt-shift-Cmd-P This retrieves your parked call

- Alt-Cmd-2 This calls your voice mail with audio

- Alt-Cmd-3 This calls your voice mail with audio using call from phone

- Alt-Cmd-4 This calls your voice mail with video.

Shift-CTRL-R Shift-Cmd-R This opens your My Room

CTRL-M Cmd-M This minimizes the window on Mac OS. On Windows, it only is used for the 
Team Telephony window

CTRL-T Cmd-T This enables always on top

- Shift-Cmd-M This opens the Main window

Shift-CTRL-C Shift-Cmd-C This opens Contacts

Shift-CTRL-F2 Shift-Cmd-F2 This opens Call History

Shift-CTRL-F1 Shift-Cmd-F1 This opens Chat History

Shift-CTRL-F3 Shift-Cmd-F3 This opens Visual Voicemail

Shift-CTRL-D Shift-Cmd-D This opens the dial pad view

Shift-CTRL-W Shift-Cmd-W This opens the web button view

Shift-CTRL-O Cmd-O Causes UCx to logout

Ctrl-7 Cmd-7 Answer incoming call with audio

Ctrl-8 Cmd-8 Answer incoming call with video
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Appendix B: Acronyms and Abbreviations
This section lists the acronyms and abbreviations found in this document. The acronyms and 
abbreviations are listed in alphabetical order along with their meanings.

ACB Automatic Callback

ACD Automatic Call Distribution

AD Active Directory

API Application Programming Interface

CC Contact Center

CLIP Calling Line Identification Presentation

CLIR Calling Line Identification Restriction

CPU Central Processing Unit

DLL Dynamic Link Library

DM Device Management

DND Do Not Disturb

DTMF Dual-Tone Multi-Frequency

ECACS Emergency Call Address Change Service

EULA End-User License Agreement

FAC Feature Access Code

FAQ Frequently Asked Question

FIPS Federal Information Processing Standard

FMC Fixed-mobile Convergence

GSM Global System for Mobile Communications

GUI Graphical User Interface

GW Gateway

HD High Definition

HID Human Interface Device

IdP Identity Provider

IM Instant Message

IM&P Instant Messaging and Presence

IP Internet Protocol

LDAP Lightweight Directory Access Protocol

LGPL Lesser General Public License

MSI Microsoft Installer

MWI Message Waiting Indication

OCS Office UCx (Microsoft)

OS Operating System

PIN Personal Identification Number

PIV Personal Identity Verification

PSTN Public-Switched Telephone Network

RAM Random Access Memory

S4B Skype for Business

SAML Security Assertion Markup Language

SIP Session Initiation Protocol

SSO Single Sign-On

TN Telephone Number

UC Unified Communications

UI User Interface

URI Uniform Resource Identifier

URL Uniform Resource Locator

USB Universal Serial Bus

UVS Video Server 

UX User Experience

VDI Virtual Desktop Infrastructure

VoIP Voice over IP

WebRTC Web Real-Time Communication

WiX Windows Installer

XMPP Extensible Messaging & Presence Protocol

Xsi Xtended Services Interface

IP Internet Protocol

Support
For questions or issues with any of your services, please call TPx Customer Care at 877-344-7441  
Monday through Friday, 9:00 AM to 8:00 PM ET.




